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Back in the earliest days of the 
internet, in January, 1994, two 
Stanford graduate students cre-
ated one of the first canonical 
websites "Jerry's Guide to the 
World Wide Web" which was 
among the first searchable 
guides of websites.  In April, 
1994, Jerry Yang and David 
Filo renamed 
their website 
Yahoo!.  By the 
end of 1994, 
while the inter-
net was still in 
its infancy, Ya-
hoo! had re-
ceived over one 
million hits on 
its website.  
Now, according 
to Wikipedia 
(source:  http://en.wikipedia.org/
wiki/Yahoo), Yahoo! is the most 
visited website on the net, with 
over 412 million unique users, 
and over 3.4 billion page views 

a day (October, 2005 data).    

   Yahoo!, which started as a 
menu based directory of inter-
net websites, now is a compre-
hensive source of online ser-
vices.  According to an interac-
tive directory on the main Ya-
hoo! page at www.yahoo.com, 

there are just 21 
distinct services 
listed, with over 
100 total Yahoo! 
services listed on 
the “Everything Ya-
hoo!” page (More 
Yahoo! Services) at 
www.yahoo.com/r/
xy. 

 I have been 
an active Yahoo! 
user since it was 

“Jerry’s Guide” in early 1994, 
and made extensive use of its 
menu to locate information on 
the thousands of websites then 
listed and categorized. Today 
the number of websites listed 
on Yahoo!                           
 (See Yahoo—page 4) 
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Yahoo! – Internet Powerhouse 
By Ira Wilsker 

WEBSITES: 

http://www.yahoo.com 

http://my.yahoo.com 

http://maps.yahoo.com 

http://mail.yahoo.com 

http://finance.yahoo.com 

http://calendar.yahoo.com 

http://www.yahoo.com/r/xy   -                          
 Everything Yahoo! 

Annual Meeting—December 8, 2007, First Methodist Church 



Cyber Chat is published monthly by the 
ChautauquaCyber Club, Inc. It is distributed to 
each member and made available to the public 
through local business, educational, and public 
library organizations.  

The Chautauqua Cyber Club, Inc. is in no way 
responsible or liable for any damages resulting 
from articles, opinions, advertising 
representations, warranties expressed or 
implies in this publication. We do not endorse   
or recommend products or services. Comments 
or opinions do not necessarily reflect the 
policies of the Chautauqua Cyber Club, Inc. , 
Board of Directors. 

The principle of equal access/equal opportunity  
for everyone is practiced. 

The primary purpose is to assist our members 
and others to become more proficient in the use 
of a computer for their personal enjoyment. We 
serve through promotion of computer literacy 
and education by being actively involved in the 
community. 

The Chautauqua Cyber Club, Inc. is a not-for-
profit organization under section 501(c)3 for 
educational purposes, and incorporated under 
the laws of the State of Florida.   
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Donate Your Old Computer 

Help Promote Computer Literacy and Education 

in Walton County 

Pentium II , III, and IV class computers, monitors, 
and printers in working condition are accepted 

Receipt issued upon request for tax credit 

Chautauqua Cyber Club, Inc.—      501(c)3 

 

To make a donation call  

    J. B. Hillard 892-3450 / 892-8100 

J. B. Hillard President 892-3450 jbh37@panhandle.rr.com 

Chip Russ Vice President 892-7452 chipruss@defuniak.com 

Estelle Norman Secretary 834-2564 ewn@gtcom.net 

Robert Connor Treasurer 892-5098 kittysfour@embarqmail.com 

Sonny Hollingsworth Member at Large 892-2456 sonnyh@defuniak.com 

Diane Merkle Web Master 897-4504 ddmerkle@aol.com 

Robert Connor Newsletter Editor 892-5098 kittysfour@embarqmail.com 

Jerry Fulaytar Assistant Editor 892-0103 twowaters@embarqmail.com 

Sam Sloan Technology Manager 892-9329 scecil@panhandle.rr.com 

Gay Russ Leader—Genealogy SIG 892-7452 mgr99@defuniak.com 

Rella Bierbower Director-Social Services 892-3782 ibierbower@panhandle.rr.com 

Estelle Norman Membership 834-2564 ewn@gtcom.net 

Board of Directors and Volunteer Staff 

Publishing information:  Articles submitted 
for publication should be in Microsoft Word or 
regular ASCII text and unformatted. Photos 
with article are encouraged. 

Presenters/Writers:  Members are encouraged 
to volunteer and present a program on software 
or hardware. Vendors will provide presenta-
tions-in-a-box, and publishers will provide 
books for review. Whatever is presented be-
comes the property of the presenter. Make your 
interest known and share. You will be surprised 
at what all is available to demonstrate. 

Cyber Chat:  This is a monthly publication. It 
is mailed to each members as a benefit, but can 
be viewed on the website at www.waltonccc.org.  

CCC Listserv:  email to 
waltonccc@freelists.org 

Free computer help by using the club listserv. Post a problem by email and 
obtain an answer (most of the time).   
The listserv is a service provided to members of the Chautauqua Cyber 
Club and invited guests. It is used for problems solving, posting club news 
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Boot n’ Reboot  
by J. B. Hillard—President 

 

 

    

The October meet-
ing went off without 
a hitch, almost! Ra-
chel Tomas from the 
Bank of American 
was not able to pre-
sent the on-line 
banking program as 

planned, but we muddled through with our 
own delivery. The Internet hookup would not 
work with the BOA online demo so we impro-
vised. I hope we were able to educate everyone 
about the security and convenience of online 
banking. 

Moving the monthly meeting from Saturday to 
Thursday was a good decision. It is allowing 
us much more flexibility on programming and 
bringing in fresh presenter talent. This month 
we are meeting at the Walton Career Develop-
ment Center (the old Vo-Tech), and will be ad-
dressed by Mr. Mike Davis, Principal. This 
will be followed by an orientation on the 
WCDC computer training program, and then 
we will have a tour of the facility. 

The WCDC has undergone a significant 
chance in their curriculum as well as improv-
ing their standing in the education commu-
nity.  A computer student can come away with 
a fully qualified education in repair, and with 
several Microsoft Certifications. They are well 
equipped to move on in life. 

The WCDC is nothing like what most of us 
knew about the Vocational Technical School. 
We are in for a real treat as this educational 
jewel is presented to our members on Novem-
ber 15. Please make a special effort to attend. 

  Happy computing  - J. B. 

Community Service Program 

“People Helping People” 

We will be providing basic computer train-
ing at the Flowersview Library up near 
Paxton.  The current plan is to hold three or 
four sessions and introduce computing to an 
underserved population.  Robert Connor 
and David Hackett will be assisting J. B 
Hillard in this community effort. 

N O T I C E 

MEETING CHANGE 

SEE PAGE 1 

 

is in the billions, and Yahoo! is generally 
considered as the second largest search en-
gine, right behind Google. 

 In addition to its search functions, 
which many prefer over Google, I personally 
use several other Yahoo! services on a regu-
lar basis.  On all of my computers the 
startup page displayed when my browser 
loads is My Yahoo! (my.yahoo.com).  I have 
this page personalized to display my stock 
quotes, market summary, weather for sev-
eral selected cities, dozens of selected news 
and feature categories, daily and weekly ap-
pointment calendar, lottery results, email 
summary, TV schedule, lowest airfares to 
the cities I fly to on a periodic basis, and 
several other items of choice.  The My Ya-
hoo! page also supports as a resource the  
                 (See Yahoo—page 4) 

Yahoo—from page 1 
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In this months’ issue of Smart Computing 
Magazine I found a nifty little tip to “tune 
up” you monitor. 

If you read the article, it tells you to go to 
download the  program from sipurl.com/
lqljw.  I went to this site, and for some rea-
son it is not ready nor available. 

Therefore, if you go to Microsoft.com and in 
the search block, type in clear type tuner 
and the site comes up.  It will ask to pick the 
printbox that looks best to you and it will 
guide you through a couple of pages and 
when you finish, your monitor should look 
like a new one.  The print text is much 
clearer and sharper especially if you have a 
flat screen.  It is like having a brand new 
monitor.  Now I usually am very skeptical 
about some of these fixes, but believe me this 
works! 

 

 

 

 

For those of you who have not heard Sam 
Sloan went to the hospital for back surgery 
on October 2.  Sam is now at home recover-
ing and we wish him well.  You might want 
to drop him a get-well email. 

 

is generally consid-
ered as the second 

largest search engine, right behind Google. 

 In addition to its search functions, 
which 
many pre-
fer over 
Google, I 
personally 
use several other Yahoo! services on a regu-
lar basis.  On all of my computers the 
startup page displayed when my browser 
loads is My Yahoo! (my.yahoo.com).  I have 
this page personalized to display my stock 
quotes, market summary, weather for sev-
eral selected cities, dozens of selected news 
and feature categories, daily and weekly ap-
pointment calendar, lottery results, email 
summary, TV schedule, lowest airfares to 
the cities I fly to on a periodic basis, and sev-
eral other items of choice.  The My Yahoo! 
page also supports as a resource the now 
common “RSS” news feeds, which allows the 
current display of information from countless 
other sources.  I have tried several other 
popular startup pages, but have always re-
turned to My Yahoo! which is my personal 
favorite. 

 Yahoo! Mail is another very popular 
service offered by Yahoo!  Millions of people 
have Yahoo! email accounts.  I personally 
have two Yahoo! email accounts, and my 
wife and daughters also have Yahoo! Email 
accounts which they use to supplement the 
email accounts provided by their employers 
or schools.  Yahoo web based email can be 
accessed from anywhere there is internet ac-
cess, and is compatible with all browsers.  
Yahoo! offers a full featured free email ser-
vice at mail.yahoo.com.  The basic free ac-
count currently offers 2 gigabytes of mail 
storage, and one of the best spam filters in 
the industry.  Yahoo! Mail also filters all 
email and attachment for viruses and other 
malware.                    (See Yahoo—page 8) 

This ‘n that 

TUNE UP THAT 

MONITOR 

Yahoo—from page 3 
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MSWord 
Convert  All Caps to  Upper & 

Lower Case 

Donna Walters called to say she received an 
MSWord document which had been typed in 
all capital letters, and asked if there was an 
easy way to convert it to traditional upper 
and lower case sentence structure. Yes; by 
selecting the target text and pressing F3 
while holding down SHIFT, all the caps will 
change to lower case. Press F3 again, while 
still holding down SHIFT, and the first letter 
of each sentence will be capitalized. Another 
SHIFT-F3 will return everything to all caps. 
However, other capitalization - such as 
names, places, and titles - will still need to 
be edited separately.  

By the way, basic email courtesy tells us to 
NEVER SEND MESSAGES IN ALL CAPI-
TAL LETTERS. All caps are fine for head-
lines or other key phrases, but are just plain 
harder to read when used throughout a 
lengthy letter. Furthermore, ALL CAPITAL 
LETTERS give recipients the feeling they 
are being shouted at. Any ALL CAP emails 
we receive here always go to the bottom of 
the list.  

Graphics Not Printing with Text 

Another frequent MSWord question: "Why 
don't pictures in my document print right 
along with the text?"  

The fix: go to Tools>Options>Print>Include 
with Document, and checkmark "Drawing 
Objects."  

Making a Document Fit on One Page 

Still another MSWord printing problem I fre-
quently hear is: "I typed a one-page docu-

ment, but a blank second sheet goes through 
the printer with each print-out."  

This sometimes happens when text has had 
a number of edits which extended it to a sec-
ond page, and then got pruned back to one 
page. Unseen on the screen may be a collec-
tion of blank spaces at the end of the docu-
ment that carry over to a second page. Press-
ing CTRL+END will send your cursor to the 
actual end of the document, whereupon any 
unneeded blank spaces can be deleted.  

A simple fix for a desired one-page document 
that overlaps onto a second page is to change 
your margin settings. Go to File>Page 
Setup>Margins and change the 1.25" side 
margins to, say, 1.1". Alternatively, you 
could choose a smaller and/or narrower font 
to squeeze everything into the default mar-
gins.  

The most frequent MSWord complaint I hear 
is: "I typed the numeral 1, pressed TAB, and 
typed in some text. Then when I pressed EN-
TER, a 2 appeared and my cursor tabbed 
over to line up under the previous text with-
out my asking it to. Now I can't get back to 
my normal paragraph settings."  

Automatic Bullets & Numbering 

This is just one of MSWord's many 
"AutoCorrect" functions. When it sees a sin-
gle character typed, followed by TAB being 
pressed, it assumes you want create a list of 
indented paragraphs beginning with left-
aligned sequential numbering (or lettering, 
such as A, B, C).  

This feature can be disabled by going to 
Tools>AutoCorrect>AutoFormat As You 
Type and deselecting Automatic Bulleted 
Lists and Automatic Numbered Lists. Then 
click AutoFormat and deselect Automatic 
Bulleted Lists.  

   (See PC Don—page 8) 

THE SENIOR TUTOR  
      WWW.PCDON.COM 
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TIP LINE 
Q: 
For awhile now, my computer has been 
restarting itself. It does it without 
warning and for no apparent reason. 
When it happens, all of my work is lost 
and I'm getting really frustrated with 
it. Do you have any suggestions as to 
why this might be happening? I'm us-
ing Windows XP. Please help!  

A: 
I feel your pain! I've never personally had 
this happen to me, but I've had some friends 
who had to deal with it. I know it was the 
most frustrating and annoying thing they 
ever went through and at the time, I wish I 
would have had some answers for them. 
That was a couple years ago and I've defi-
nitely learned a lot since then, so don't fret, 
because I do have some good suggestions for 
you all today!  

Here's a scenario of what could be happen-
ing to you. You're working on your computer 
(maybe checking your e-mail, browsing 
through a couple Web sites and you have 
your music player going at full blast) and 
everything seems to be going fine. Then all 
of the sudden, your computer just shuts 
down. What happened? Why did it do that? 
Well, if your computer is continually re-
starting itself for no good reason, there are 
several things that could be causing that to 
happen. In this type of situation, you have 
to do some troubleshooting to figure it out, 
but you should be able to do that rather 
quickly. Here are some things you can check 
on and look out for.  

For starters, if your computer is running at 
too high of a temperature, it will turn itself 
off. If your CPU is running above the 60 de-
gree (Celsius) mark, you may be close to 
burning it out and a lot of systems are set 

up to turn off automatically when an unsafe 
level is reached. So, what could be causing 
your system to overheat? Well, a big part of 
it is the programs you're running. For ex-
ample, a lot of the music programs these 
days (like iTunes and Windows Media 
Player) use a lot of processing power when 
they're working with your music files. So, if 
you're using one of those programs a lot, it 
could cause your CPU to heat up. That can 
happen if you're using too many programs 
all at the same time as well. It all just de-
pends on what you use.  

If this happens to you, the best thing you 
can do is get inside your computer and clean 
it out. If too much dust is collecting around 
the fans in your CPU, it can restrict the air-
flow and your computer won't be able to cool 
down properly. To clean out your CPU, open 
it up and either use compressed air or a 
toothbrush to eliminate some of the debris. 
Once you clean some of the dust particles 
out, the temperature should drop a great 
deal and your computer should be back to 
normal.  

Now, if overheating wasn't your problem, 
the next thing you'll want to check on is 
your memory. If your computer hits a bad 
spot of RAM memory when it's trying to ac-
cess it, it could just go crazy and restart it-
self. The best way to test this out is to re-
move a stick of your memory, one by one, 
until you find the culprit. Remove one and 
then let your system run for awhile. If your 
computer seems to be working better, you'll 
know the cause and you can then replace 
that piece of memory for better results.  

If you still haven't figured out what's wrong 
with your computer, there is a setting you 
can change to see if it helps at all.  

 

              (See Tip Line Page-8)  



 

The Fix For Frustrations 
By J. B. Hillard, Chautauqua Cyber Club, Inc. 
www.waltonccc.org 

Common problems continue to frustrate com-
puter users no matter their level of expertise. 
Sometime it’s pure lack of knowledge for the 
beginner  or just being forgetful for the more 
advanced.  Here are a few suggestions to fix 
common frustrations we all encounter from 
time to time.  

Forwarded eMail:  How many jokes and 
other frequent and unwanted 
eMails do we receive from well in-
tentioned friends. Many are for-
warded several times before they 
reach  us. They arrive with nu-
merous >> symbols in front of 
each line. Be kind to your friends 
and remove these symbols before 
the message is forwarded. 

To strip the garbage I use an older 
application called eCleaner that can be 
downloaded at http://ecleaner.tripod.com. A 
more modern method Text Monkey, 
www.textmonkey.com. Both are free. 

Shorter URL’s: URL’s seem to get longer 
and longer. For sending one to a friend use 
www.shorturl.com or www.snipurl.com which 
will shorten the URL no matter how long it 
is. Then send the shorter URL to a friend you 
want to share the exciting site with. 

Online Speed Test:  There are dozens, if not 
hundreds, of online speed test. I use 
www.speedtest.com because that’s the one 
recommended by my Road Runner ISP.   

Other good ones can be found at 
www.pcpitstop.com/internet , and 
www.analogx.com/contents/download/networ
k/nsl.htm.   

The latter is a download while “speedtest” is 

run from the website.  NetStat gives much 
more information that can be recorded.                       

Keep in mind speed test are relative, but one 
can be helpful to prove your connection speed 
is not what it should be.  

Download software:  Downloads go to a de-
fault directory. If you want to find a specific 
download  then you must find the default 
download directory. This is just fine for most 
folks, but I prefer creating a specific folder on 
the c: drive so it’s easy to find for sharing by 
email or copying to a CD.  

Find an application you want 
and start the download process. 
When the first screen pops up 
with Run, Save, Cancel, select 
and click  Save. 

When the “save as” screen pops 
up, in the “save in” click the ar-
row to change where the save 
will be, select Local Disk (C:). 

Another screen pops up with all the fold-
ers/files you have on the C: drive.  

To the right of the Save In block there are 
some icons, select the Create New Folder, a 
new screen opens and a block will be high-
lighted with “New Folder”. Type in a name 
that easily identifies the application , then 
click Open.  

You will then see the file name of the folder 
just created. Down at the bottom in the “File 
Name” will appear the download.  Click Save 
and let the download happen. 

It will be saved to the C: drive in the newly 
created folder. To install the application just 
click the folder and execute the install.  

When you want to copy or send the download 
it’s easy to find on the C: drive.                                       
       
     END 
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There's actually a setting within Windows XP 
that tells your computer to restart itself when 
a system error occurs. So, if you turn that op-
tion off, you should be good to go. To do that, 
go to Start, Control Panel and click on the 
Performance and Maintenance link. 
Next, click on the System link and then hit 
the Advanced tab. Now, under the Startup 
and Recovery section, click on the Settings 
button. Once there, uncheck the box that says 
"Automatically Restart," which is located 
under the System Failure section. Now, this 
setting will stop your computer from restart-
ing, so you may not want to leave it off, but 
you can at least use it until you figure out 
what the true problem may be.  

You should also try to think back to anything 
you've recently done on your computer. 
Maybe you installed a new piece of software 
or hardware. If so, try removing that and see 
if the problem persists. Or, you could try 
downloading the latest drivers from the 
manufacturer. Sometimes that's all it takes. 
The restart problem could also be caused by a 
virus or some spyware, so make sure you run 
your scans to see if anything comes up. You 
should also go to Start, Control Panel, 
Add/Remove Programs and remove any 
programs from the list that you don't need. 
Getting rid of unnecessary items is always a 
good thing to do.  

Well, there you have it. Hopefully one of the 
above suggestions works for you, but if the 
problem continues, try contacting the manu-
facturer of your computer or try to get some 
answers from a professional computer repair 
store. Either way, I hope your restarting 
blues are now gone forever!        

~ Erin 

This article is copyright www.worldstart.com, 
used with permission 

                                     
           

If you later decide you want to create some 
numbered indented paragraphs , type your 
first numbered paragraph, select it, go to For-
mat>Bullets & Numbering, and make your 
style choices. Each subsequent ENTER will 
begin a sequentially itemized paragraph to 
match the first one. To break the cycle, go to 
Format>Bullets & Numbering, and choose 
NONE.  

Reprinted with permission of Don Edrington,     
www.pcdon.com 

 
The free Yahoo! Email 

also supports almost all email programs, for those 
that prefer a mail reader, rather than traditional 
web mail.  I periodically download my Yahoo! web 
mail into either Eudora or Outlook Express, de-
pending on which Yahoo! email account I am us-
ing at the moment.  For those who still prefer us-
ing web mail, as millions do, Yahoo! offers two 
viewing options; the traditional web mail inter-
face, or the new “beta” email interface that ap-
pears on the screen much as Outlook or other 
email reader would appear.  It should be noted 
that Yahoo! also offers an upgraded (fee) email 
service for businesses and those with their own 
domain names.  It has been rumored in the media 
that Yahoo! may start to offer email accounts 
with up to unlimited storage. 

For those interested in investing, and who like to 
follow the latest financial news, Yahoo! offers a 
comprehensive and free financial news resource 
at finance.yahoo.com.  Topics accessible by tabs 
include investing, news and opinion, personal fi-
nance, and “my portfolios”.  Each tab opens a di-
rectory of relevant topics which provides compre-
hensive financial information.  The personal fi-
nance tab connects to information on banking and 
budgeting, career and work, college and educa-
tion, family and home, insurance, loans, real es-
tate, retirement, taxes, and how-to guides.  Active 
investors may find the “My Portfolios” tab helpful 
                                                             
   (See Yahoo—page 10) 

Yahoo—from page 4 

Tip Line—from page 6 PC Don—from page 5 



PAGE  9 CHAUTAUQUA CYBER CLUB,  INC. VOLUME  9   ISSUE 11 
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1031 W. Hwy 90             892-6794  /  892-5809 

               www.gdsys.net 

    

 

Club Shirt 
Size, S, M, L, XL, 2X 

$15.00                                             

50% cotton 50% polyester 

Stain resistant 

Robert Connor— kittysfour@earhtlink.net 

 

 

 

A Career in Computing 
 

Main Campus  Chautauqua Center 
100 College Blvd  908 W. Hwy 90 

850-678-5111  850-892-8100 

Niceville, FL 32578  DeFuniak Springs, FL 32435 

I Fix Computers 

Membership Application:   Chautauqua Cyber Club, Inc. 

Name:__________________________  Spouse:____________ 

Address:__________________________________ ZIP______ 

Telephone:____________ Email:________________________ 

(Membership is based on full 12 months: Join this month and  

renewal is same month next year  

Single and Family member-
ship are the same 

$22.00 per year 

$11.00 full time OWC        
students 
Chautauqua Cyber Club, Inc.                
P. O. Box 251, DeFuniak Springs, FL 
32435 

 

749 Baldwin Ave 

DeFuniak Springs, FL 32435 

850-892-0988 

www.defuniak.com 

Internet Service, dial-
up & high speed—full 

service home and 
business solutions 

Northwest Florida               
Association of Computer 

User Groups 
www.nwfacug.org 



Membership renewal: 

It’s time to renew if the      
date on your mail label           
is Nov 07 or before 

CHAUTAUQUA CYBER CLUB, INC.
  
P.  O.  BOX 251 
 
DEFUNIAK SPRINGS,  FL.  32435  

in that it allows the user to enter and save any number of stocks, bonds, and 
mutual funds, as well as indices, and display the current (subject to exchange 
required delays) values.  Charts, news, messages, profiles, statistics, and other 
useful information are provided on each portfolio item listed.  For those who 
want nearly real-time portfolio valuations, the user can also enter number of 
shares, costs, and other information, which will then display a detailed table of 
gains and losses, as well as summary information. 

I was recently visiting two of my kids out of state, and needed some information 
on shopping and restaurants.  I went to maps.yahoo.com and entered their ad-
dress, and generated a street map of selectable scale.  On the screen I could se-
lect the type of business I was looking for, and the name and location would be 
displayed on the map.  Clicking on the icon created on the map would provide 
additional information on the selection.  We were able to read reviews of restau-
rants, and with a single mouse click we could generate detailed driving direc-
tions from the house to the restaurant or other desired business.  I have found 
this service invaluable when staying in hotels and I want to know what is 
nearby.  When driving directions between points are generated, the user can 
decide what to print and display, such as directions only, directions and detailed 
maps, or maps only.  This service is useful to both the traveler who needs driv-
ing directions and information on waypoints, and the local user trying to find 
points of interest.  According to a recent news article, in April, 2007, there were 
29.4 million users of Yahoo! Maps, making it one of the top mapping services on 
the net.  Yahoo also recently announced that it is adding detailed driving direc-
tions to Maps for 34 European countries, enhancing its broad appeal. 

It should be no surprise to readers of this column that I am a very busy per-
son.  By choice, I use Yahoo! Calendar at calendar.yahoo.com. I can enter 
appointments, events, and other activities with starting and ending times.  I 
can also have repetitive events, such as board meetings, automatically en-
tered on the calendar by specifying “third Thursday” or some similar nota-
tion.  Yahoo! Calendar and can also import and export information between 
it and Outlook, as well as most PDAs such as Palms and Pocket PCs.  Items 
listed on the calendar can be kept private, or can be selectively displayed as 
public, such as if an organization desires a public calendar of events.  Yahoo! 
Calendar also offers the free option of emailing reminders, or sending the 
reminder to a cell phone or other mobile device. Obtained from APCUG with 
the author's permission for publication by APCUG member groups.  


